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Evolve eBooks Installation 
 
We recommend you download the eBooks to your computer first and then to your Evolve Homepage. 
 
Note: You need to have administrative rights to download the bookshelf to your computer.  If you do not have 
these rights with your work computer, contact your IT department. 
 
Installing Bookshelf | Mac OS X 10.4 or Later 
Go to the following Website: http://vitalsource.com/software/evolve-ebooks 
 
1- Download Bookshelf 2- Open Installer 3- Install Evolve eBooks Bookshelf

 

Select the ‘Mac OS’ option. Click 

on the  icon to start the 
download. The eBooks Bookshelf 
Disk Image will download to your 
Mac. 

Locate the Evolve eBooks 
Bookshelf Disk Image and 
double click on it, to mount the 
disk image on your desktop. 

Once the Disk Image is mounted to 
your desktop double click on 
Bookshelf or Evolve eBooks disk. 
Drag The Bookshelf icon to your 
Applications folder. 

 
4- Add to Dock 

 
5- Clean Up

 
6- Launch Bookshelf 

Go to your Applications folder, 
Locate Evolve eBooks Bookshelf 
and drag it to your dock. 

Drag the Disk Image Bookshelf to 
the trash to eject it, as well as the 
Bookshelf installer. 

Click on the Bookshelf icon in your 
dock to launch VitalSource 
Bookshelf. 
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Installing Bookshelf | Microsoft Windows XP/Vista/7 
Go to the following Website: http://vitalsource.com/software/evolve-ebooks 
 
1- Download Bookshelf 2- Run Installer 3- Install .Net 3.5SP1 

 

Select the ‘Microsoft Windows’ 

option and click on the  icon to 
start download. When prompted 
click the Run button. 

Once the Installer has been 
downloaded, click another Run 
button and then choose your 
language for the installer. 

If you do not have Microsoft .Net 
3.5SP1 installed, it will install prior 
to Bookshelf being installed.   If .Net 
is present, you will be taken to step 
5. 

 
4- Restart Computer 

 
5- Install Bookshelf 

 
6- Launch Bookshelf (Evolve eBooks)

Once .Net is installed, you will be 
prompted to restart your computer. 

Click on the Next buttons until you 
come to the Install button. Click 
install. Then click the Finish 
button. 

Double click on the Evolve eBooks 
icon on your Desktop to launch 
VitalSource Bookshelf. 
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Follow these instructions to make your Evolve Select eBooks available on your Evolve Homepage. 
Note: you need to be using an Internet Explorer 7 (or higher) or Firefox browser.  This installation will not 
work using an Internet Explorer version lower than 7. 
 

1. Log into Evolve using your Evolve username and password.  This will be different than your ‘Evolve 
Select’ username and password. http://evolve.elsevier.com/staticPages/index.html 

2. Choose  from the Evolve login page.  
3. Enter your Evolve eBook password.  The username field will be automatically populated with your 

email address.  
4. When asked for a redemption code, click on ‘Skip this Step’. 
5. You will automatically return to your homepage, and in a moment the eBooks heading should appear 

under “MY CONTENT”. 
6. Click on the eBooks Online link. 
7. Your books will appear. 

 
 
Follow these instructions to make your Evolve eBooks available on a second computer. 

1. Start by downloading the bookshelf at this site: http://www.vitalsource.com/software/evolve-ebooks/.  
Click Run and follow the prompts while downloading the bookshelf.  You may be asked to download 
Microsoft.Net Framework 2.0 as well. If so, just follow the cues as directed. 

2. After the bookshelf installation is complete, open the Evolve Select bookshelf using the  icon found 
on your desktop. 

3. The bookshelf should open on the Welcome Page.  If not, click the welcome button on the left side. 
4. Click on “Log-in” and enter your email address and password for Evolve eBooks. 
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Evolve Select eBooks Getting Started 
 
Now that you’ve completed the download and registration and synced your account to Evolve, you may access 
your eBooks from your computer (offline) or online from any device with an Internet connection including 
most web-enabled mobile devices via the browser.  If you are not able to access your online account via 
Evolve, please use the following URL http://evolveebooks.elsevier.com 
 
In order to ensure all your notes and highlights sync between computers, please enable syncing.  From the 
library, click on ‘Edit’ from the menu on the top of the screen and select ‘Preferences’.  Select ‘Syncing’ and 
check the box as shown here: 

 

  
 
 
Working With Highlighters 
 
The Evolve eBooks Bookshelf gives you complete control over your highlighters.  Updates made to 
highlighters are done in real time and all of your notes and highlights are fully searchable. 
 
Adding a new highlighter in Bookshelf 
1- Press the New Highlighter Button 2- Name the Highlighter 3- Adjust the color 

To make a new highlighter for use 
in your books press the New 
highlighter button at bottom right 
side of the primary bookshelf 
window. Or go to the File menu and 
select New Highlight 

A new highlight will appear with 
the rest of your global highlighters. 
From there you can ‘right click’ on 
the highlighter and select Rename 
Highlighter to change its name. 
Once you are finish, click with the 
left mouse button and your name 
will be set. 

To adjust the color of the 
highlighter, ‘right click’ on the 
highlighter you want to change and 
select the Change color for "Name 
of highlighter" select a color from 
the palette and click the Okay 
button. 

 



 
 
 
 
How to delete a global highlighter 

1- Locate Highlighter to delete 2- Delete Highlighter 3- Transfer Highlights (if 
applicable) 

To delete a highlighter, ‘right click’ 
on the highlighter you wish to 
delete. 

Select Delete highlighter "Name 
of highlighter" (if there are no 
highlights or notes present the 
highlighter will be automatically 
deleted). 

If you have made notes and 
highlights with that highlighter, you 
will be presented with a dialog box 
for reassigning your highlights and 
notes or to delete all of the notes 
and highlights for that highlighter. 

 
How to create a highlighter and a note in a book: 

1- Select Text 2- Select Highlighter to use 3- Press Highlight (or Make Note) 
button 

To make a highlight (or a highlight 
with a note) in a book, select text as 
if you were going to copy and paste. 

Select the highlighter you want to 
use from the drop down list in the 
book window. 

Press the Highlight button to 
highlight the text. Press the Make 
Note button to make a highlighter 
and to bring up a window to add a 
note with the highlighter. To save 
the note: simply close the window 
and the note will be auto saved. 
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Tips and Tricks for working with Highlighters and Notes: 

• In order to make a note, you have to have a highlighter that accompanies it. But you can have a 
highlight by itself. 

• Highlighters with notes will have a ‘Sticky Note’  icon next to the highlight. 
• If you have a highlight you want to add a note to, ‘double click’ anywhere on the highlight and the note 

window will appear. Once you have typed your note, close the window to save the note. 
• You can add new text at any time by ‘double clicking’ on the highlight to bring up the note window, 

add the text you want to and close the note window to save the updates to the notes. 
• To delete a note, ‘double click’ on the highlight to have the note window appear and delete all the text 

in the note window and close the note window. 
• When you change the highlighter color in the main bookshelf window, it will change all of the 

highlighters to the new color. 
• To delete a highlight, ‘right click’ on the highlight and select Remove Highlight. 

Notes Sharing & Friends Feature 
 
With the Evolve eBooks Bookshelf, you can share your notes and highlights with your friends and classmates. 
It is also possible to subscribe to your friends’ notes and highlights or have your students subscribe to yours.  
Before you can share notes and highlights you will need to have ‘Note Syncing’ turned on.   
 
Sharing a highlighter- Requires an Active Internet Connection 
 
1- Find the highlighter you wish to 
share 2- Turn on Shared Highlighters 3- Select sharing preferences 

To share a highlighter, click on the 
highlighter you want to share in the 
Bookshelf window. 

In the main Bookshelf window, 
you'll see the box where you can 
turn on your notes and highlights, 
click the Share this highlighter 
with: checkbox. 

Choose ‘Anyone’ or ‘Friends Only’

NOTES__________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________ 
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About Sharing Notes to Anyone:  

• Before you can share notes and 
highlights you will need to have ‘Note 
Syncing’ turned on. 

• In order for another user to see your 
Notes and Highlighters that are set to 
‘Anyone’, they will need to know your 
Bookshelf User ID. 

• When someone is subscribing to your 
notes, they will only see notes for 
books that you both have in your 
license. 

• You will have to have an active 
internet connection and Bookshelf 
open to publish any changes to your 
notes. 

 

 
 
About Sharing Notes to Friends Only:  

• Before you can share notes and highlights you will 
need to have ‘Note Syncing’ turned on. 

• You can have only one friends list, so any 
highlighter that is set to ‘Friends Only’ will share 
the same friends list. 

• Anyone who subscribes to your notes and 
highlights that are in your friends list will also 
automatically be subscribed to any shared 
highlighters that are set to be shared to ‘Anyone’ as 
well. 

• When someone is subscribing to your notes, they 
will only see notes for books that you both have in 
your license. 

• You will have to have an active internet connection 
and Bookshelf open to publish any changes to your 
notes. 

 
How to set up your Friends list- Requires an Active Internet Connection 
1- Open Friends Tab 2- Enter in Friend 3- Verification 

First you will need to open up your 
friends list. Go to the Edit menu > 
Preferences > Friends tab (Windows) 
| Bookshelf menu > Preferences > 
Friends tab (Mac OS X) 

Enter in the user’s name and email 
address and click the Add Friend 
button. (Note: the person you are 
adding must have an account with 
the Evolve eBooks Bookshelf in 
order for them to see your notes 
and highlights) 

Once your friend has been 
verified, add another friend, or if 
you are finished close the window.

 
NOTES__________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________ 
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How to Subscribe to a users Notes and Highlights- Requires an Active Internet Connection 

1- Click the ‘Subscribe’ button 2- Enter in Bookshelf ID 3- Sync Other User’s Notes 

To subscribe to another user’s 
notes and highlights, first click on 
the ‘Subscribe’ button. 

Enter in the user’s Bookshelf ID (The 
email address they used to register for 
eBooks) and press the ‘Subscribe’ 
button. 

Beneath your highlighters will 
appear the highlighters of the user 
you just subscribed to. 

 
Tips and Tricks for working with Shared Notes and Highlights: 

• It can take up to 15 minutes or more before the shared notes and highlighters fully sync to your 
computer. 

• When you subscribe to other users’ notes, you will only see notes for books that you have in 
common. 

• You cannot edit another user’s notes and highlighters 
• A shared note will be identified by the buddy icon that is attached to it. 
• To unsubscribe from another user’s shared notes and highlighters, right click on the user’s name and 

choose Unsubscribe "User Name." 

Backing up your Books, Highlighters, and Notes 
Your books, highlights, and notes are important to you and your studies.  The Evolve eBooks Bookshelf 
allows you to automatically store your notes and highlights to our redundant servers safely and securely.  
Also, unlike other digital services, you can download your book as many times as you need (as long as the 
computer you are downloading it to is one of your two activated machines.)  
 
NOTES_________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________
________________________________________________________________________________________ 8



 
How to enable automatic highlight and note syncing (synching requires an active internet connection) 
1- Go to preferences 2- Select Sync Tab 3- Toggle Syncing 

To turn on Syncing go to the:  

• Edit > Preferences menu 
(Windows users) 

• Bookshelf > Preferences 
menu (Mac OS X users) 

Click on the ‘Syncing’ tab Select the ‘Sync Highlighters 
between all computers’ checkbox. 

 
About note syncing 

• On second launch of Bookshelf, you will be prompted to turn on Syncing. 
• In order to Sync your notes between your two computers you will need to have syncing turned on for 

both machines. 
• When ‘syncing’ is turned on, your notes and highlights will also be viewable through Bookshelf 

Online. 
• If you want to Share notes and Highlights, you will need to have ‘note syncing’ turned on. 

 

Editing your Profile 
Editing your Profile requires an Active Internet Connection 
To edit your profile you will need to log into your account page. 
Once you have logged in to your Profile Page, you can update the following:  

• The email address associated with your account 
• Your name 
• Your security question and response 
• Your password 
• Communication preferences  

NOTES_________________________________________________________________________________
_______________________________________________________________________________________
_______________________________________________________________________________________
_______________________________________________________________________________________
_______________________________________________________________________________________
_______________________________________________________________________________________
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Content Reuse- Copy, Paste, Print, Figure capture 
 
Elsevier and Evolve eBooks allow the user unlimited use of content to copy & paste text for reports, study 
guides, and patient teaching handouts.  Pages of eBooks may also be printed for portability and to use as 
handouts in class.  A final great feature that users love is the ability to ‘right-click’ on an image or table, copy 
and paste it into PowerPoint, Word or other document.  Images and tables may also be saved as .jpgs to insert 
into your documents, to use on exams or for reports.  The reuse of content falls under fair use of 
copyrighted material and is not to be done for profit, resale or mass distribution beyond your 
institution.   
 
Content Accessibility & Navigation 
 
Searching, the most popular eBooks feature, is fast and easy.  Searching a term from the library will yield 
results from all your books.  Searching within a book will yield results from that book only.  Highlighting a 
term in a book will allow you to ‘right click’ and quick search that term through any book or reference on your 
computer.  Notice when you are typing a term, the field will auto-populate with suggested spellings and related 
terms for your entry.  The search results pane will allow you to preview results and see the number of hits in 
any given book before you click and select a book to read more.   
 

 

Evolve eBooks offer two font sizes depending on your reading preference.  The font toggle icon  
is found on the Book toolbar at the top of your eBook.   
 
There are various navigation tools and page layout options available depending on your preference - look for 

these icons  
 
Evolve eBooks utilize the text-to-speech (TTS) reader in your computer’s operating system (OS).  The quality 
of the TTS voices depends on what your OS offers and is not a function of Evolve eBooks.  To use TTS, open 
a book and go to the Book Menu then choose ‘Start Reading’.  Evolve eBooks is Americans with Disabilities 
Act (ADA) compliant and works with JAWS and other third-party accessibility programs.  Please visit this 
URL for the ADA VPAT and for more information on accessibility http://www.vitalsource.com/508  
 
Navigating the contents of your book is simple using these tabs in the eBook. 

 
 
NOTES_________________________________________________________________________________ 
________________________________________________________________________________________ 
________________________________________________________________________________________ 
________________________________________________________________________________________ 
________________________________________________________________________________________ 
_________________________________________________________________________________________
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Accessing your Books through your Mobile Device 

Step 1: Adding a link Bookshelf Online to your iOS device's home screen 

 

Click on the Safari icon on your 
iPhone/iPod Touch/iPad Go to http://online.vitalsource.com

Once the page loads, press the "+" 
button and then press the "Add to 
Home screen button." 

 
Choose the name for your Alias to Bookshelf Online 
and press the "Add" button. 

You will now have an Alias to Bookshelf Online 
on your iPhone/iPod Touch/iPad. 

NOTES__________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________ 
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Step 2: Logging into Bookshelf Online through your iPhone/iPod Touch/iPad 

 

Once you click on the Bookshelf Online link you 
created, Safari will launch and you'll be taken to the 
login screen. 

Once the page loads, you will enter in your login 
and password. Then click the "Sign-In" button. 
You'll be asked if you want to store your password. 
You can choose either option. 

 

On first launch, you'll be asked to accept the EULA. Once accepted, you'll be taken to your eTextbooks. 
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Evolve eBooks System Requirements 
 
Hardware: Online and offline eBook access each has a set of optimal system requirements defined more 
specifically herein.  

Bookshelf Online Browser Requirements: 

• Apple's Safari 3.0 or greater 
• or 
• Microsoft's Internet Explorer 6 or greater 
• or 
• Mozilla's Firefox 2.0 or greater 

Computer Requirements 

• 1024x768 resolution monitor/display or greater 
• Internet Connection for registration and viewing of eTextbook 

Hardware Specifics: 

• 2.0 gHz INTEL processor 
• 1 GB of RAM 
• DVD Drive 
• 1024x768 resolution monitor/display 
• Ethernet port, internet access, and online registration 

Software Requirements: 

• Windows XP SP2 (32 bit) / Windows Vista (32 or 64 bit )/ Windows 7 (32 or 64 bit) 
• Windows users are also required to install Microsoft .Net 3.5SP1 
• Mac OS 10.4 or greater 

Bookshelf Online for Mobile Devices Browser Requirements: 

• iOS’s Safari mobile 

Supported Mobile Devices 

• iPhone 
• iPod Touch* 
• iPad* 

* In order for an iPod Touch/iPad to work with Bookshelf Online, you must have a constant connection to a 
wireless network. 
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